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Part 1: Introduction 
 

What is EndNote? 
 

EndNote is a reference management software package which is used to manage 
bibliographies and references when writing assignments, dissertations, theses and 
articles. 
 
EndNote allows you to: 

o Store all the references that you find during your research. They can be exported 
automatically from most databases, or entered manually. 

o Store PDF files, pictures, graphs, tables, etc. 
o Add citations to your work and create bibliographies in any output style (e.g. APA, 

Chicago, IEEE, MLA and Vancouver). There are over 6,000 styles to choose from. 
 

How to obtain EndNote 
 

EndNote X9 is available on all the PCs in the University’s open access PC suites. 
 
If you wish to obtain EndNote X9 for a ‘personal’ University-networked PC in an office or 
postgraduate room: 
 
o Go to the Salford Service Portal:  https://salfordprod.service-now.com/sp 
o Click the Request Something link. 
o Click EndNote, and fill in your details on the form. 

 

EndNote for home use 
 
Our licence allows you to install EndNote on your own device. 
 

o Go to the Student Software Portal: https://lssoftware.salford.ac.uk and log in with 
your network username and password. 

o Click on EndNote so that it is highlighted, then scroll down to the bottom of the 
screen and click Next. 

o You will be given a link to install EndNote and a product key. Copy the product key. 
o Click the link, then click the link for the version you want – Windows or Mac. 
o Follow the EndNote installation instructions and enter the product key when 

prompted. 
 
Staff can request the software by contacting the Digital IT Service Desk by phone: 0161 295 
2444 or email: Digital-ITServiceDesk@salford.ac.uk 
 
Please note that you will only have access to EndNote while you are a registered student 
at Salford, so it is recommended that you make a back-up of your library with 
EndNote Online. This is free and is yours for life. Please see Part 6, pp. 48-49, for more 
information about EndNote Online. 

mailto:Digital-ITServiceDesk@salford.ac.uk
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Part 2: The EndNote Library 
 

An introduction to EndNote libraries  
 

o Your EndNote references are stored in a database called a Library.  
EndNote libraries have the file extension .enl.  

This is the file you open. 
 

 
 
 
o Each Library has a corresponding folder with the extension .Data. This folder 
will have the same name as the Library, and it is where images, PDF files, etc. 
are stored. If you move, copy, rename or delete a Library remember to do the 
same with its corresponding .Data folder. 
 

o There is no limit to the number of references you can store in a Library, although it is 
recommended that you do not exceed 100,000 to maintain efficient performance of 
the database. 

 
o Although the software allows you to create as many Libraries as you wish, it is strongly 

recommended that you keep all your references in just one Library. This way you will 
know where to find them, and will not create duplicate records in other Libraries. 

 
o Within your Library you can create Groups (or subsets) to help you organise your 

references. See Part 4, pp. 24-27, for information about creating and using Groups. 
 

o References can be transferred easily between EndNote X9 and EndNote Online, so you 
may choose to use the full software when you are University and the Web version when 
you are at home. It is highly recommended that you use EndNote Online to back up 
your EndNote references. You can also use EndNote Online to share references and 
work collaboratively with others. Please see p. 48 for information about EndNote Sync. 

 
o Each EndNote record stores the information required to reference it in a bibliography. 

Other information, to help you with your research, such as keywords, notes, abstracts 
and URLs can be stored in a record as well. You can also attach PDF files and images to 
EndNote records, and you can annotate PDFs with highlights and your own comments. 

 
o EndNote X9 allows you to share your entire EndNote library with up to one hundred 

people (who are using EndNote X7.2 or later), no matter where they are located or what 
organisation they are affiliated with, and everyone can add to, annotate and use the 
library at the same time. If you are working as part of a research team and wish to use 
this service, look for the ‘Library Sharing’ video on the EndNote YouTube channel: 

https://www.youtube.com/user/EndNoteTraining 
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Creating an EndNote library 
 

o Open EndNote from the Windows Start button (or search for it).  

o Close any “welcome” screens and accept the Licence Agreement. 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

If you are using the University’s network: 
 
open your F: drive, and save your Library there. 
You can give your library a new name if you wish, but note 
that it must be saved as EndNote Library (*.enl). 
 

If you are using your own device: 
 
save your EndNote Library on to its hard disk, 
for example, in your Documents folder. 
This is the safest place to keep it. 

Go to the File menu 
and select New. 
 

 

DO NOT SAVE YOUR ENDNOTE LIBRARY TO A CLOUD 

(e.g. OneDrive, Google Drive) 

-  IT WILL BREAK! 
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Library overview 
 

 

 

 
The EndNote Library screen is split into three panes: a Reference List pane, a Groups 
pane, and a Tab pane. 
 
 

 

 

The Reference List Pane. 
This shows a list of all your references, each displayed as a 
single line. 
You can sort the references by clicking on a column heading. 

To get back to your library go to the File menu and 

select Open to open an existing library. 

Click the Question Mark  icon 

to go to EndNote Help. 
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Reference overview 
 

 

 

 

 

 

To see all the details for a reference you can either use the Reference tab, or 
double-click on it in the Reference List pane. 

Each reference has its own unique number. EndNote 
uses these numbers for formatting, and they cannot 
be changed. 
 

The font and size should both be set as Plain, unless 
you need a special style for a character. You do NOT 
need to set italics or bold; EndNote will do this for you. 
 

Use the Aa button if 
you need to change 
case – for example, 
for titles imported all 
in capitals. 

Use the Options button 
to hide or display empty 
fields in the record, and 
display the Ratings tool. 

When you have finished 
editing a record, click the 
small [X] close button.  
This will save any changes 
you have made to it. 

When you are typing in numbers, 
for example, for pages or 
volumes, you do not need to type 
v. or pp. before them – just the 
numbers. 

As well as the fields that are required to 
format your bibliography, EndNote provides a 
number of fields for your own use, for 
example, to write your own research notes, 
and attach files and images.  
How you use these fields is your own choice. 
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Importing a Term List for journal titles 

 
Depending on the subject area you are working in you may wish to import a Journal Term 
List into your EndNote Library before you start saving any references.  
 
If you are working in fields such as Medicine and Biosciences, some referencing styles 
require you to use officially recognised abbreviations for journal titles and other styles 
want full journal titles – and the databases you are retrieving records from may use full 
titles or abbreviated titles. A Journal Term List will give you the flexibility to use either form 
of title. 
 

 

 

 

 

 
 
 
 
 
 
 
 
Choose the subject list you 
want (Medical is the most 
comprehensive) then click 
Open.  
The list of journal titles and 
their corresponding 
abbreviations will imported 
into EndNote. 

Go to the Lists tab  
 
and select Journals,  
 
then click Import List. 
 

Go to the Tools menu and 
select Open Term Lists, 
then Journal Terms List. 
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Part 3: Adding References to Your Library 
 

When you search databases to find journal articles, books and other information it is 
usually possible to import the records you find directly into EndNote. This has the 
advantage of allowing you to import references accurately without having to re-type all 
the information yourself. 
 
Most databases contain a download or export button that will send your search results 
directly to EndNote, pick the correct import option to start the import process. If you have 
your EndNote Library open before you start your records will be imported automatically. 
If you Library is not open EndNote will prompt you to open it.  
 
In a few databases importing records is a two-step process where you save the results of 
your search into a file, then import that file into your EndNote library using an Import Filter. 
 

 

Please note that with some databases it is not possible to import references automatically 
into EndNote. In these cases you will need to either type the information in manually or 
copy and paste it into the appropriate reference form, following the instructions on pp. 21-
22 of this guide. 
 

 

 

For instructions about how to import records into EndNote from the databases provided by 
the Library, please see the separate guide: “Downloading References from Databases into 
EndNote”, available at: 

https://www.salford.ac.uk/skills-for-learning/home/using-and-referencing-
information/manage-references 

Note: Before you try to import any records into EndNote you should 
make sure you have your reference list displayed – like this. 
 

Close any references you have open. 
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Importing references from Web of Science 

 
1. Open a web browser and go to  

                      http://www.salford.ac.uk/library/access-to-e-resources 
2. Click the letter W, then the Web of Science link. 
3. Click the red Link to database button. 

 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.  Type in your keywords and 
click the Search button. 

5.  At the results 
screen, tick the 
checkboxes next 
to the records 
you want. 

6.  Go to the top of the page, and 
select EndNote Desktop from 
the menu.  

7.  Select Author, Title, Source, Abstract from 
the menu, then click Export. 

If you are using Google Chrome 
click the download in the bottom 
left-hand corner so that it opens. 
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Editing records 

 
Sometimes the records you import will have titles all in capital letters. This will create 
incorrectly formatted references in your bibliography, so you will need to edit these 
records. 

 

 
 

 

 

 

Remember to replace capital letters for any proper nouns. The above reference will now 
be correctly formatted, as such: 

 

8.  Return to your EndNote library. Note that the references you have 
just downloaded are in a Group called Imported References.  

To open a reference double-click on it in the list. 

Open the record and 
highlight the text you 
wish to correct. 

Click the Change Case [Aa] button and make your selection, then click the Close [X] 
button to save your changes. 
 
As a general rule, article and chapter titles are in sentence case, i.e. capital letter for the 
first word and proper nouns only. 
Book and journal titles usually have a capital letter for all the main words. 
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Importing references from Science Direct 

 

o Go to the Resources page at: 
                     http://www.salford.ac.uk/library/access-to-e-resources 
o Click the letter S, then the ScienceDirect link. 
o Click Link to database. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type in your keywords, then 

click the Search icon. 

Click the 
checkboxes 
next to the 
articles you 
want, 

then go to 
the Export 
menu. 

Click the download box to 

open it in EndNote. 

Click Export citation to RIS. 
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Importing the fulltext PDFs 

 

EndNote can locate and import fulltext PDF articles. Select one or more references, a 
group, or your entire library and have EndNote scan for fulltext available to you. When the 
fulltext is found, EndNote downloads it and links it to the appropriate reference 
automatically. 
 
Please note that the success of this facility will depend on which database you got the 
references from, and whether we have access to the fulltext articles. It will also be more 
successful when you are using a University-network PC, as the system will recognise that 
you are entitled to fulltext access. 
 

 

 

 

 

 

 

 

Go to  All References. 
 

Click on one of the items in the Reference List area, so that it is highlighted, 
then go to the Edit menu and choose Select All (or use the <Ctrl> + A keys). 
This will highlight all the references in the list. 
 

Click the Find Full Text icon. (If you hover you mouse over 
the icons these boxes will tell you what they are for.) 
 
EndNote will start searching for the PDFs. 
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Attaching PDFs manually 

 
If EndNote cannot find and attach the PDF for you automatically (see pp. 12-13) you can 
try to find the file yourself, save it, and then attach it to the reference manually. 

 

 

 

 

 

 

 

 

 

 

Please note that you won’t always be able to access fulltext articles – the Library does not 
subscribe to everything! For things we do not have, use our Document Delivery Service:   
 
                            http://www.salford.ac.uk/library/use/document-delivery 

If the download has been successful you will 
see a paperclip icon in the Reference pane, 
which indicates there is a file attached. 
 

The PDF will be displayed in the Preview pane. 
Click the Open PDF icon to open it full size. 
 

Click to highlight the item you want, 
then click the Open Link icon.  
This will return you to the database it 
came from. 

If the PDF is available, save it somewhere you 
will be able to find it again – for example, your 
F: drive or Desktop. 
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When you insert a PDF file or an image, EndNote copies the file and places the 
copy in a .DATA folder, which is found in the same folder as the main library file.  
If you move your library to a different computer remember to always copy the 
.DATA folder along with the library. 
 

Once you have saved the PDF click 
the Attach File (paperclip) icon in 
the Preview Pane.  

Browse to where you have the file 
saved, then click the Open button.  
 

Make sure you have the correct 
reference highlighted.  

The file will now be attached to the EndNote 
record, and will display in the Preview Pane. 
Click on the Open PDF icon to open it full size. 

To save your changes, click somewhere else in your 
Reference Pane, then click Yes when prompted. 
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Annotating PDFs  

 
EndNote allows you to easily view and annotate the PDFs you have attached to your 
references. Open the PDF you want to read, using the Open PDF icon (see p. 12). 
 
 
 
 

 
  

 

 

 

 

 

Use these icons to Save, Print or Email 
the PDF and your annotations. Use the Highlight icon if you 

wish to highlight any text. 

If you would like to write any comments on the PDF click 
the Sticky icon, then click where you would like to write 
your comment. 
A balloon will appear.  Double-click on it. 
This will open a box where you can type your comments. 
When you have finished click the cross in the corner to 
close the comment box. 
 

To find your notes later use the EndNote Search Panel. 
You may need to click on the arrows to see it. 

Select PDF Notes from the menu, then type in words you 
used in your sticky note. 

Click the Search button, and any references with matching PDF notes will be displayed. 
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Importing PDFs to create new records 

 
EndNote allows you to convert existing collections of PDF files into EndNote records, by 
extracting DOI information from the PDF files, matching it with data from CrossRef 
(www.crosssref.org) and capturing bibliographic 
content. 
 

Therefore, to work, the article will need to have the 
DOI number printed on it somewhere. 
 

 
Before you start you should save your PDF files into a single folder – this will make the 
importing quicker. 
 
 

What is a DOI? 
A DOI (Digital Object Identifier) is a unique string of characters used to identify an electronic journal 
article or (less frequently) an electronic book. Unlike a URL, a DOI is permanent – therefore using a 
DOI in a bibliographic reference provides a persistent link to the article. 
 
To retrieve an article where you have the DOI, turn it into a URL by preceding the DOI with the 
following: 

http://dx.doi.org/  
 
e.g.  http://dx.doi.org/10.1016/S1474-4422(14)70320-5 

 

Go to the File menu, 
 
and select Import. 

Select Folder. 
 
(If you only have one PDF 
file to import, select File). 
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If you import a PDF that doesn’t have a DOI, or the DOI is incorrect, it will create an 
EndNote reference that looks like this. The file will be attached to the record, but the only 
information that has been captured will be the filename, which is used as the title. 

 

 

 

 

 

 

 

 

Or you might prefer to search for the record again, and import the reference from a 
database or Google Scholar. 
 

Click the Choose button and 
browse to the folder where 
you’ve got your PDF files 
saved. 

Select PDF from the Import 
Option menu (if it is not 
already selected). 
 
Click the Import button. 

The PDF files will be imported (you can see this from the paperclip icon) and the 
records will be created from the information in each file. 

If you want to edit the record, alternate 
between the PDF tab and the Reference 
tab to copy and paste the information 
into the appropriate fields – see p. 4 for 
more information. 
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Importing references from Google Scholar 

 
o Open a web browser and go to http://scholar.google.co.uk/ 
o Enter your search. 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Click the double quote (Cite) ” icon under the reference 

you want. 

Click the RefMan link, then open the downloaded file. 
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Because Google Scholar is a free resource you will not get the same amount of information 
that you would from a subscribed database. However, once you have imported a record 
from Google Scholar you can ask EndNote to look for updates to improve the record. 
 

 

 
 
 

 

Open the record you have just imported from Google 
Scholar, then click the Find Reference Updates icon. 

Any available updates will be displayed on the left and 
highlighted in blue. You can choose to either update the 
entire record, or just the missing fields, or you can edit the 
record manually, by clicking the appropriate button. 
Click the Save and continue button. 

If EndNote cannot find an updated reference for the item, 
you could try returning to Google Scholar, clicking the title 
link for the article, then seeing if there is an option to 
download the record into EndNote from the database. 
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Using Library Search for book records 

 
You will probably need to use books in your research as well as journal articles. You can 
save records for books from Library Search, but they may need some editing before they 
will create correct references. 
 
Please note, this works best on Google Chrome. 
 
To access Library Search: 
o Go to the Student Channel: http://www.salford.ac.uk/students 
o Click the Library & Learning Support link. 
o Click the Library Search link. 
o Search for a book, using the Books & more option. 
 
 

 
 
 
 
 

 
 
 
 

Click the quotation mark  ” 

next to the book you want. 

Click EXPORT RIS, then click 
DOWNLOAD. 
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Records for books imported from Library Search often need editing. 
Double-click on the imported reference to open it. 

The Place of Publication is entered 
twice.  
You need to delete it, and the colon, 
from the Publisher field - so that it 
remains only in the Place Published 
field above. 

Check the Edition field.  
 
If the word ‘ed.’ or ‘edition’ appears, delete it. 
You should only have the ordinal number (2nd, 3rd, etc.)  or the word 
New or Rev. 
 
When you have finished editing the record click the close [x] button to 
save the changes. 

You will now have a correctly formatted reference, for example: 

Waller, G. A. (2010). The living and the undead : slaying vampires, exterminating zombies 

(New ed.). Urbana, Ill.: University of Illinois Press. 

 

Make sure the Reference Type is set to  
Book.  
Some references are imported as 
‘Generic’, which will give you an incorrect 
reference. 
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Adding references manually 

 
Usually, references will be added to your Library by importing them directly from online 
databases, but occasionally you will need to make a manual record – for example, for a 
webpage, blog or unpublished report which doesn’t have an electronic record for it. 
 
Sometimes, you will also need to edit records that you have imported from databases. 

 

 
 

 

 

 

 

Click the New Reference icon. 
 
A blank form will be displayed. 

Select the correct Reference Type for the 
publication you wish to cite. This is important to 
help EndNote correctly format your references. 

See the next page 
for advice about 
entering authors. 
 

Use the Scroll Bar or 
arrows to display 
more fields. 
 

Type in the information into the relevant fields – see p. 5 for more 
information. 
Remember that every reference has to have all of the following 
elements, otherwise it will be incorrect: 
Who - wrote or created it. 
When - it was published of produced. 
What - is the title of the work. 
Where - you found it (or how to find it) - Place of Publication and 

Publisher; Volume, Issue and Page Numbers; DOI; or URL. 
 

When you have finished entering all 
the information, click on the close 
button [X]  to save the reference. 
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Author & editor names 
 

When you have more than one author or editor, each of their names 
should be typed on a separate line, i.e. press the <Enter> key after each 
name.  
 
Personal authors & editors 
o Author names should be entered with the last name followed by a comma and the first 

name (or initials), e.g. Smith, John or de Gaulle, Charles  
 
o You must type capital letters where required,  

e.g. Smith, John  (not smith, john) or van der Voordt, Theo 
EndNote cannot guess where capital letters are or are not used in names.  

 
o If you are entering initials instead of full names, be sure to type a full stop or a space 

between initials, (for example "Fisher, J.O." or "J O Fisher"), otherwise EndNote 
interprets the initials as a single name: "Jo." 

o Wherever possible, use full names. 
 
 
Corporate authors 
o When entering corporate authors (companies, institutions, organisations, etc.), put a 

comma after the name, for example:    
University of Salford, 

This ensures it will be correctly formatted by EndNote. 
 
o If your corporate author name includes a comma in the name itself, use two commas 

in place of the first comma, for example: 
Institute for Social Research,, University of Salford 

 
Anonymous works 
o If a reference has no author, you should leave the Author field blank. Do not enter 

"Anonymous." The style that you use to format the bibliography determines how 
anonymous references are treated.  

 
o Note that if a work is published with "Anonymous" printed on the title page, most style 

guides request that "Anonymous" be entered as though it were the author name – in 
which case you should type Anonymous into the author field. 

 
Using et al., etc. 
o Enter all author names for a particular reference. EndNote will truncate the list of 

authors with "et al." or "and others" as required by the citation style you have chosen. 
 
New entries for Authors, Editors, Journal Titles and Keywords will appear in red. EndNote 
has an auto-complete function which will complete the typing the next time you use that 
author, etc. 
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Attaching images 

 
EndNote allows you to embed images, figures, tables, charts, etc. into your references. 
This is a useful way to store any graphic material you find in the course of your research. 
 
You can insert a graphic file into the Figure field of any EndNote reference. So, while a 
reference to a journal may contain primarily bibliographic information, you can also include 
an illustration that appeared with the journal article. 
 
The Figure, Chart or Table, and Equation reference types can be used specifically to 
catalogue images and files, and may contain minimal reference information. EndNote can 
then be used to insert figures and format a list of figures (if appropriate) in your paper. 
 

 
 
 
 

  

 

 

 

 

 

You can find out more about working with images in the guide “Referencing Images and 
Tables” available at: 

www.salford.ac.uk/skills-for-learning/home/using-and-referencing-
information/referencing 

Open the record you wish to use, then click 
the Attach Figure icon. 

Click the Choose File 
button and browse to 
where you have the 
image saved. 

 Click the OK button. 

 

Scroll down the reference screen to see your image. 

Double-click on it if you wish to see it full-sized. 

Type a caption to describe the image. 
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Part 4 : Organising Your References 
 

Using groups 

 

Groups make it easy for you to organise your references without having to make multiple 
EndNote libraries.  
 
There are several types of groups to help you organise your references in EndNote. Some 
of these groups are automatically generated and some are ones that you can create 
yourself. You can further organise your references by storing multiple groups in custom 
Group Sets. 
 
Some things to note about using groups: 
o You can create a maximum of 500 Custom Groups and Smart Groups (combined) in a 

single library. 
o A single reference will never appear more than once in a particular group. However, 

you can add that reference to any number of groups. 
o Removing a reference from a Custom Group does not delete it from the library. It 

removes the reference from the group subset, but the reference still exists in the 
library. 

o Deleting a reference from the All References group also deletes it from all groups in that 
library. The deleted reference will be moved to the Trash group. 

o If you delete a reference from Trash it no longer exists. 
 

Creating a custom group 
 

You can create custom groups as you wish, in order to organise your references. You might 
wish to make groups for each chapter of your thesis, or for different papers you are 
working on. 
 

 

 

 

 

 

 

 

Go to the Groups menu 
and select Create Group. 
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A box will appear in the Groups 
pane. 
Type in a descriptive name for the 
group you have just made, then 
click the <Enter> key. 

If you are not already there, click All References. 

 

You can also file references by right-clicking on the one 
you want, going to Add References to, then selecting 
the group you want to add it to. 

You can then start filing references in groups by dragging and 
dropping them from the Reference List pane onto the group name. 
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Creating a smart group 

 
Smart groups are built with search strategies, for example, works by a particular author or 
matching some subject keywords. Smart groups are dynamically updated as you add 
references to and edit references in the library.  

 

 

 

 

 

 

 

 

 

 

 

 

Any references you have in your EndNote library 
which match the search criteria for your Smart 
Group will automatically be filed in the Group, as 
will any future references you add. 

 

 

 

Go to the Groups menu and 
select Create Smart Group. 

Type in a descriptive 
name for your group. 

Type in keywords that will match some of your 
references. 
If you wish to search across everything in your library 
select Any Field + PDF with Notes from the menu. 
Use other fields and combinations as you wish. 

Click the Create button. 
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Creating a group set 
 

If you make custom groups and/or smart groups to help you organise your references, 
before long you might end up with a large number of groups. To help you organise your 
groups you can create group sets. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

  

 

Give your group set a name. 

Use your mouse to 
drag a group and 
drop it underneath 
the name of the 
group set. 

 

From the Groups menu 
select Create Group Set. 
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Duplicate records 

 
As you add more and more references to your EndNote Library, from a variety of 
databases, it is likely that you will get duplicate records for the same item. 
 
To avoid anomalies in your citations and references once you start adding them to your 
Word document, you need to ensure that you only have one record for each item. (This is 
another reason to only use one EndNote Library). 
 
o Go to the References menu and click Find Duplicates. 
o Any duplicate records will be displayed, with the areas of differing text highlighted. 

This will help you decide which record you wish to keep. 
o Generally, you should keep the older record, as this is likely to be the one you have 

edited, added attachments to, and most importantly, already used for citations in your 
document. 

 
 

 

 

Note that the criteria used by EndNote to identify duplicate records won’t always catch all 
of them. You will still need to look through your Library and delete any records you don’t 
want. It is probably easiest to do this if you sort your Library by ‘Author’ or ‘Title’. Click on 
the column header to do this. 

You can tell which is the older record by 
looking at its record number (preceded by  #). 

If necessary, you can copy & 
paste information from your 
‘reject’ record into the one 
you want to keep – for 
example, the more recent 
record may have a DOI. 

When you have finished any editing, click 
the Keep This Record button for the one 
you want to keep.  

The other record(s) will be sent to Trash. 
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Part 5 : Cite While You Write 
 
EndNote works with Word to easily and quickly cite references, and create a paper with 
properly formatted citations, a bibliography, figures, and tables. 
 
This is all done using the “Cite While You Write” (CWYW) toolbar, which you will see in 
Word once you have installed EndNote on your computer. 
 
 

 
 
If you cannot find the CWYW toolbar please contact the Digital IT Service Desk, at: 

Digital-ITServiceDesk@salford.ac.uk 
- it is possible the EndNote program has not installed correctly on your PC. 
 
 
 

Inserting citations & bibliographies into a document 

 
 
1. Open your EndNote library. 
2. Open your Word document. To practice you might like 

to use some “play” typing like this: 
 
 
 

 

 

 

Click the EndNote X9 tab to see 
the EndNote tools.  

3.  In the document click the place where you wish to place 
a citation in the text. Remember to leave a space between 
the last character and your cursor, and that your citation is 
placed before any punctuation (a comma or full stop).  
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In EndNote: 

 

 

 

 

 

 

 

4.  Click once to highlight the 
reference you want to use.  

5.  Click the Insert Citation button. 

6.  You should now see a citation in your text, and the 
first reference in a list at the end of your document. 
 

Not what you were expecting to see?  
EndNote defaults to the ‘Annotated’ referencing style, which includes the abstract. To 
change it go to the Style menu and select the style you want – if you are doing a taught 
course at Salford this will be APA 6th. 
If the style you want is not listed, go to Select Another Style… to see the full list. 
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Temporary citations  

 

 

 

 

 

 

 

 

 

When you are working on very large document (like a thesis) adding more citations will 
get slower. 
 
 
 
 

 

 

 

 

 

Writing at home? 

If you want to continue writing at home but you don’t have EndNote on your device you 
can type in your own temporary citations. You must use curly brackets; type the author’s 
name and year, for example: {johnson, 2010}. 

When you open your Word document on a PC which does have EndNote installed (i.e. 
when you get back to university) the temporary citations you have typed will automatically 
format themselves and the references will be added to your bibliography. 

When you insert your first citation it 
may look like this. The brackets { } 
and # number indicate this is a 
temporary citation. 

To format your citations, click the Instant Formatting 
is Off button and select Turn Instant Formatting On. 

To make it faster go to Convert 
Citations and Bibliography and select 
Convert to Unformatted Citations. 
When you have finished adding your 
citations click the Update Citations and 
Bibliography button to format them.  
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Direct quotations and page numbers 

 
Many referencing styles require that a citation for a direct quote (or one where you have 
only changed the words slightly, for example, to ensure correct grammar) must include 
the page number where you found it. 
 
Page numbers are not required if you have paraphrased a source, however may still wish 
to include them – they will help your reader pinpoint where you found an idea, especially 
in a long work, such as a book or thesis. 
 

 

 

 

 

 

 

 

Remember that a direct quote should be placed in quotation marks,  or 
indented from both margins if it is longer than two or three lines. 

Click the Edit & Manage Citation(s) 
button on the CWYW toolbar. 

Check that the correct 
citation is highlighted. 

Type in the page number(s). You do not need to 
include p. or pp. – EndNote will do this for you. 
Click the OK button. 

Click on the citation you wish to 
edit, so that it is highlighted. 
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Note: the EndNote templates for many styles are not set to accept page numbers as 
described above. If this is the case with style you have chosen you can still use the Edit & 
Manage Citations button to add a page number, but you will need to type it into the Suffix 
field.  

 

 

Changing the citation format 
 

In your writing you will often integrate the author’s name into your text, for example: 
 
 Gray and Wegner (2012) described the … 
 
In this case, you do not repeat the authors’ names in a citation at the end of the section.  

 

 

 

 

 

This is a free text field, so you will 
need to type in the punctuation, 
spaces and p. or pp. before the page 
number(s).  

To format your citation this way, place your cursor where you want the 
author’s name to be – usually this will be at the start of your paraphrase. 

Insert the citation in the usual way (see pp. 29-30.)  

The correctly formatted page number 
will now be added to the citation. 
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There may also be times where you have mentioned both the authors and the date of an 
article in your text, (for example, In his book of 2010, Austin detailed the ….)  and therefore 
do not need either in your citation. You do still need the reference in your bibliography, 
and you should use EndNote to insert this. 
 

 

 

 

Right-click on the citation you have just 
inserted,  
 
go to Edit Citation(s) 
 
and select Display as: Author (Year). 

Your citation will now be correctly formatted, i.e. authors’ names incorporated into the 
sentence, separated with the word ‘and’, and followed by the date in parentheses. 
wording so it forms a grammatically correct sentence. 

Type the year and author into your text. 

Place your cursor where you would normally add the citation, i.e. at the end of the 
sentence.  
Go to EndNote and add the citation in the usual way (see pp. 29-30). 
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Adding multiple citations 

 
There will be times when you have summarised the content of two or more different 
papers into a single sentence or paragraph, and will need to insert a multiple citation. 
 

 

 

Right-click on the citation 
you have just inserted. 

Go to Edit Citation(s), then select 
Show Only in Bibliography. 

The citation will be removed from your text, but the coding remains 
which ensures that the reference will stay in your bibliography. 

In your document, place your cursor 
where you need to put the citation. 
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In EndNote, hold down the <Ctrl> key while you select the references 

you wish to cite, then click the Insert Citation button. 

The multiple citations will be inserted in your document in the correct format – in this case, all 
three articles are enclosed in one set of parentheses, in alphabetical order and separated by 
semicolons. This will vary according to the reference style you have chosen. 

You may wish to add more works to the multiple citation, for example, you have read another 
work that supports your statement. To do this, click anywhere on the citation so that it is 
highlighted, then return to EndNote and use the Insert Citation icon to insert the new citation. 

EndNote will automatically re-sort your citations 
into the correct order – in this case alphabetically. 
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Creating secondary citations 

 
There are times that you will find something referenced in a book or an article that is so 
useful or interesting you want to use it in your own writing. This might be a citation for 
another article, or an illustration, graph or table take from another work. 
 
Generally, you should try to find and read the original work and use that as the source of 
your citation and reference. However, there are times when this isn’t possible, for 
example, you may not be able to get hold of the original work, it is in a language you can’t 
read, or the citing author has summed up the ideas in the original more succinctly or 
elegantly than you could ever manage. 
 
When you use a secondary citation like this, your in-text citation should mention both 
works but your bibliography only includes a reference for the work you have actually read 
yourself. You can use the CWYW tools to format a citation in this way. 
 

 

 

 

 

 

 

 

 

 

 

 

 

For example, you may wish 
to use this idea, attributed 
to Campbell, in an article 
you have read by Drezner. 
 

Insert the citation for the article you have read, then 
click on the citation so that is highlighted then click the 
Edit & Manage Citation(s) button on the toolbar. 
 

Make sure the correct citation 
is highlighted. 
 

In the Prefix field, type in the authors and the year 
for the work you have seen cited plus the words 
such as ‘cited in’. (You should check the exact 
wording required by the style you are using.) 
Remember to leave a space after the last word. 
Click OK. 
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Deleting citations 
 

Because of the large amount of coding behind each citation you 
insert, you cannot simply remove a citation by using the <Delete> 
key.  If you try to do this, you run the risk of leaving a bit of coding 
behind – which will break it. 
 
Nor can you delete a citation you have put in the wrong place by 
using the ‘Undo’ button in Word.  
 
To remove a citation you must use the CWYW tools. 

 

This will format the secondary citation and add 
the correct item to your bibliography. 
 

Click on the citation so it is highlighted, then click 
the Edit & Manage Citations button. 
 

Click the arrow on the Edit Reference button, 
and select Remove Citation.  
 

Click the OK button. 
 

Your citation and all its coding will now be removed cleanly from your document. 
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Inserting images into your document 
 

If you have attached images to your EndNote records (see p. 23)  you can use EndNote to 
insert images and captions into your document. 
 

 
Note: for a large document with several chapters (for example, your thesis) you may prefer 
to insert your images manually and use the Word Caption Tools. There is a great video to 
show you how this is done here: http://media.salford.ac.uk/Play/10355 - and lots more 
useful information about formatting your thesis or dissertation at Skills for Learning: 

www.salford.ac.uk/skills-for-learning/home/it-and-digital-skills#tab_dissertation 
 

 
To insert an image into your document first press the <Enter> key once or twice to make a 
space where you want the image to go. 

 

 

 

 

 

 

 

 

 

 

On the CWY toolbar, click the small 
arrow in the bottom right-hand corner 
of the Insert Citation icon on the 
EndNote ribbon,  
then select  Insert  Figure from the 
menu. 

Highlight the one you want 
and click the Insert button. 

A list of matching image references will 
be displayed.  
Click on each one to see a preview.  

A search form will be displayed. Type 
in a keyword (e.g. from the caption 
you gave the image) and click the Find 
button. 
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Depending on the bibliographic style you have chosen, the image you have 
just inserted may be displayed in “List of Figures” at the end of your 
document, with a Figure reference in your text – as in these examples. 

 
 
 
 
 
 
 
 
 
 
 
In other bibliographic styles, the image will be displayed in the body of your text. If you 
wish, you can edit your Output Style in EndNote to determine how images are displayed. 
 
Whenever you use illustrations, graphs, tables, etc. in your writing you should explain the 
purpose of them, and cite them as you would for any other literature you have used. For 
more information see the “Referencing Images and Tables” guide, available at: 

www.salford.ac.uk/skills-for-learning/home/using-and-referencing-
information/referencing 

 
You should have separate bibliographies for ‘Lists of Figures’ and ‘Lists of Tables’. EndNote 
doesn’t generate these automatically, so to create them follow the instructions on the 
next page, Exporting  a Bibliography. 
 
Before you export your List of Figures it is a good idea to put them all into a group. You 
can make a Smart Group (see p. 26) as follows: 

 
Give your group a title. 

Select Caption from the first menu, and 
is greater than from the second menu. 

Type a blank space (i.e. press your space bar) 
here, then click the Create button. 

This will file every record with anything in the 
Caption field in the Smart Group.  
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Exporting a bibliography 

 
Sometimes you may wish to use EndNote just to produce a bibliography for you – for 
example, you may prefer to type your in-text citations yourself, or you may wish to create 
a separate list of illustrative material (see above). 
 
This can be done within your EndNote library; the exported bibliography may then be 
copied and pasted into your document. 
 
 

 

 

 

 

1.  Click on All References or the Group 
you want to create your bibliography from 
(e.g. this Group could be for a chapter of 
your thesis or for your images). 

2.  Select the references you want included in the 
bibliography, either by holding the <Ctrl> key while you 
click on them, or by using <Ctrl><A> to select all. 

3.  Click the Export button. 

4.  Click the This PC icon and choose 
where to save your file (e.g. F: drive).  
 

5.  Give your file a name, and select Rich Text 
Format (.rtf) from the Save as type menu.  
 

7.  Click the Save button. 
6.  Select the Output style 
you want from the menu. 
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Putting it all together – merging chapters 
 

When writing a big document such as a dissertation or thesis many people to choose to 
write each chapter as a separate document. If you have been using EndNote for your 
referencing this will mean that each chapter has its own set of in-text citations and its own 
reference list at the end. 

This guide explains how to merge your chapters so you have one complete list of 
references at the end of your dissertation or thesis. 

 

1.   Make copies of your chapters 

o Save each chapter with a new name, for example, Chapter 1 copy, Chapter 2 copy, 
and so on. This way, you will have your originals to return to if anything goes wrong.  

o Save all these copies in same place so you can find them easily. 
 

 

 

2.   Unformat your citations 

 

 

Go to the EndNote X9 tab, then click 

Convert Citations and Bibliography. 

Select Convert to Unformatted Citations. 
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3.   Repeat for all your chapters 

Follow the above instructions to unformat the citations in all your chapters. 

 

4.   Merge the chapters into a new document 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You should notice that the Instant 

Formatting has turned off, your citations 

now look like this, and your reference list 

has disappeared. This is all good. 

Open a new Word document and make a couple of 
blank pages (CTRL+Enter) so you have somewhere for 
your title page, table of contents etc. 

Note: You might find it easier if you use the Zoom tool 
to make your pages small, like these examples. 

Open your Chapter 1 copy document 
(with the unformatted citations) and 
use CTRL+A to highlight all the text. 

Use CTRL+C to copy the text, and then 
use CTRL+V to paste the chapter into 
your blank document. 
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To continue to add citations, 
turn your Instant Formatting 
back on. However, if you find 
the updates are now very slow, 
you may wish to leave it turned 
off.  

Now repeat these steps to paste Chapter 2 copy here – remember to use 
the version with unformatted citations. 
Repeat, until all your chapters have been copied into the new document. 

Once all your chapters are merged, click the 
Update Citations and Bibliography button. 

You will see a status bar showing its progress. 
Depending on how many citations you have, 
this could be quite slow. 

You will now have a single list of all your 
references at the end of your document. 

Don’t forget to SAVE it! 



 

45 

Some things that might go wrong 

 

Has your Reference List disappeared? 

And are your citations are now in curly brackets with a # number? 

 
Don’t be alarmed.  Your ‘Instant Formatting’ has turned itself off. These are called 
Temporary Citations, and there is more information about them on p. 31. 
 

 

 
 
 

Is your Reference List in a different font? 

You can change the font to match the rest of your document. 

 

 

 

 

 

 

 

Click Instant Formatting is Off and 
select Turn Instant Formatting On. 

Your citations should re-format instantly, but if they 
don’t, click Update Citations and Bibliography. 

Click the little arrow in the corner of 
the Bibliography section. 
Click the Layout tab, then select the 
font and size you need.  (If you are 
writing a PhD thesis this will usually 
be Times New Roman, 12.) 
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Are there initials in your citations? 

 
You may notice that initials, or even given names, are 
appearing in some of your citations.  
 
This is not actually a fault; it is EndNote differentiating 
between ambiguous citations.  

You need to be able to tell which citation matches which reference – this is the whole point 
of referencing. 

 
The appearance of initials 
happens when you have 
works by the same author 
but with their name entered 
differently, or you have 
different authors with the 
same family name. 

 

If you don’t need initials to differentiate citations (for example, the works are from 
different years) you can ask EndNote to stop including them. 

 
 

 
 
 

 

 

 

 

 

 

 

 

 

 

Select the style you want from the menu. 
 

Go to the Edit menu. 
 
 
Select Output Styles, 
 
 
then “Edit APA 6th” (or the name of the 
style you are using). 
 



 

47 

 

 

 

 
Click the Update Citations and Bibliography button in Word document and the initials will 
be removed.  

  

Click Ambiguous Citations,  
then click to un-tick the Include the author initials … box. 
 

Then click Author Name,  
and click to un-tick the Use initials only … box. 
 
Go to the File menu and use Save or Save As to save the style 
with the same name (e.g. APA 6th.) 
 

Note: in this case, the letters a and b have been added to the citation to distinguish between 
works written by the same person in the same year. EndNote does this for you automatically. 
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Part 6: EndNote Online 
 
It is highly recommended that you use EndNote Online to make a back-up of your EndNote 
library. By synchronising your EndNote X9 library with your Online account your references 
will be backed up every time you open or close your library, and you will be able to access 
them anywhere you have internet access. You can also install the EndNote Online CWYW 
tools in Word on your home computer. 
 
Your EndNote Online account is yours for life, which means you will still have access to 
your references after you have left Salford – remember that your access to EndNote X9 
will expire after you have left the University. 
 
 

EndNote Sync 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the Sync Library button. 

Click the Sign Up button. 

Note: If you already have an EndNote Online 
account you can sign in here. 
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Using EndNote Online 

 

Although the principles of using EndNote Online are the same as using the software 
version, it looks quite different and the processes for saving references into it and using 
the CWYW tools are also different. 
 
There are a series of videos and a PDF guide to using EndNote Online on the Skills for 
Learning website at: 

www.salford.ac.uk/skills-for-learning/home/using-and-referencing-
information/manage-references#tab_endnote-online 

 
o For help saving references see Section 2: Adding references to EndNote  
o For help creating citations and references see Section 4: Cite While You Write 

 
 
 

  

Enter your email address, first and last 
names in the boxes provided, and make 
yourself a password following the 
guidelines provided.  
When you have completed this, click the 
Sign up button. 

When you have completed the 
registration process click the Sync 
button. 

This will send your references from 
EndNote X9 to EndNote Online. 
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Part 7 : Where to Publish? 
 
Have you written a paper for publication and are now wondering which journals to submit 
it to? The Manuscript Matcher tool in EndNote X9 works with Web of Science and Journal 
Citation Reports to find the best most credible, high-quality journals that match your topic 
and references. 

 

 

 

  

When you have finished (or nearly finished) writing your 
paper, go to the EndNote X9 tab and click the Manuscript 
Matcher button. 

A form will open.  

Copy the Title and Abstract for your 
paper into the relevant boxes. 

 

Note: Your references will have 
already upoaded from your Word 
document. 

Click the Find Journals button. 

 

A report will be produced, showing the top ten matches for your paper and 
what those matches are based on, bibliometric data for each journal, and a 
link to take your to each journal’s submission page. 

Good Luck! 
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Part 8 : Getting Help 
 
o If you need advice about obtaining or installing EndNote please contact the Digital IT 

Service Desk: 
• email : Digital-ITServiceDesk@salford.ac.uk  
• phone: 0161 295 2444 

 

o For any help using EndNote please contact the Academic Support Librarian for your 
subject area. Their details can be from the Choose a subject menu at:  
   http://bit.ly/sflsubject 

 

o The EndNote website provides a huge amount of help, including online tutorial guides 
and videos, FAQs and a Knowledge Base, a user forum and Customer Support: 

http://endnote.com/  
 
 
 
 

Skills for Learning 
 

Available at http://www.salford.ac.uk/skills-for-learning or 
access through the logo on the Student Channel. 
 

 
A wealth of advice, tutorials and guides to finding and using information, academic writing 
and referencing, and much more, plus information about classes you can book on to and 
where you can get one-to-one help. 
 
• For more tips and advice, see our Blog:        blogs.salford.ac.uk/digital-literacy-skills 

mailto:Digital-ITServiceDesk@salford.ac.uk

